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https://nesoge.com 
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Installation 
 

 

FileEspresso is a content manager (files and folders) for Windows. The installer can be downloaded 

from the website https://nesoge.com  

 

 

Requirements 
 

The following prerequisites are required to install this app: 

• Windows version 11 operating system (version 10 is also supported) 

• 8 GB of RAM 

• .NET framework version 4.8 

 

 

Setup 
 

After downloading the "fileespressosetup.zip" file, right-click the file, select the "Properties" 

command and uncheck the "Unlock" option if the file is locked. Unzip the compressed file into a 

folder and launch the "FileEspressoSetup.exe" program. Accept Windows permission requests. 

During the setup wizard, press the "Cancel" button at any time to abort the installation. If .NET 

framework 4.8 is not present it will be installed automatically. 

 
 

 

 

Select the language to use during setup and 

confirm with the "OK" button. 

 

 

Accept the terms of the agreement to continue 

installation. Press the "Next" button. 
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Select the destination folder. We recommend 

using the one proposed automatically. Press 

the "Next" button. 

 

 

 

 

To create a shortcut to the program on the 

desktop, tick the option. Press the "Next" 

button. 
 

 

 

 

Press the "Install" button to confirm the start of 

the installation. Wait for the file copy to 

complete. 

 

 

Press the "Finish" button to finish the 

installation. 
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Using the app 
 

 

At the end of the installation, the program should start automatically (if the option “Launch 

FileEspresso” was enabled during setup). To start the program manually, double click on the 

"FileEspresso" shortcut on the desktop. 

 

 
 

First start 
 

At the end of the installation, the program should start automatically (if the option “Launch 

FileEspresso” was enabled during setup). To start the program manually, double click on the 

"FileEspresso" shortcut on the desktop. 

At the first start, the application's first configuration wizard is automatically launched. We 

recommend leaving the settings automatically suggested by the program. At the end of completing 

this wizard you will be able to use the program. Press the "Next" button to continue. 
 

 

 

The most important setting is the selection of the “Home” folder which will act as a central repository 

for all content (files and folders). We recommend using the proposed folder. If you want to use a 

different folder this must be new or empty. Once set and in use it cannot be renamed or moved 

because it is linked to the data it contains. If in the future the FileEspresso installation is moved to a 

new computer, by copying the “Home” folder to the new computer and redoing the initial setup, all 

the data will be retained. Press the "Next" button to continue. 
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Set the username and password to access the system. Press the "Next" button to continue. 

 

 

 

Press the “Finish” button to complete the wizard. The main program window will appear. 
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Category configuration 

 

To see the list of configured categories go to the “Category / Tag / Type” menu and click on the "Edit 

category" command. 

A list of categories is shown on the screen. The proposed list is purely indicative, as an example, and 

can be completely customized. If a category is not used it can be deleted by pressing the “Delete” 

button. To name a category, select it in the list so that the relevant row is highlighted, enter the new 

name in the text box and press the "Rename" button. Each category must have a unique description. 

 

 

 

Tag configuration 
 

A tag is metadata, that is, an entity represented by a key and its value. For example the "Item size" 

tag could have a list of possible values "S", "M", "L", "XL", "XXL". Or the "Weight (Kg)" tag could have 

a number value between 0 and 150. 

To manage the list of custom tags go to the "Category / Tag / Type" menu and select the "Edit tags" 

option. 

 

 

You can add as many tags as you want to describe a property in one or more categories. The tags 

can in fact be combined with the categories so that they can be described in detail. Furthermore, 

tags cut across categories. A tag can be combined with different categories. The tags initially 

proposed are indicative/example type. If they are not used, they can be deleted by selecting the tag 

to highlight the relevant line and then pressing the "Delete" button. However, if a tag is in use it 

cannot be deleted and an explanation message will be displayed. It will first need to be removed 

from association with the matched categories. If used at the contents data level (user files and folders) 

it must also be removed from there in order to be able to delete it. 
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File type configuration 

 

In the “Category / Tag / Type” menu, select the “Change file type” command to display the list of file 

types (defined based on the file name extension). When you start it for the first time, a default list is 

provided which you can however modify freely. It is advisable to include in the list the file types that 

are normally used on your computer. 

 

 

Associate tags to a category 

 

As already mentioned, it is possible to define a list of predefined tags associated with a category.  

 

 

 

In the "Edit categories" window, pressing the "Link tags" button opens the window that allows you 

to associate all the tags to be combined by default with the selected category. On the left is a list of 

all tags configured in the system. On the right, under the category name, are the currently paired 

tags. By selecting a tag in the left list or in the right list and using the "Link tag" / "Unlink tag" buttons 

you can add and remove tags associated with the category. If you want to add a tag that has not 

been previously defined, you can press the "New" button without having to exit this procedure and 

enter the tag management menu. 

In the future, when user contents (files and folders) are managed, each user will be asked to match 

them to a category that describes them. The list of default matched tags will be proposed by default. 

The user will still be able to customize this list by removing or adding, in each specific case, the 

desired tags. 
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As you can see from the example above, the "Status" tag has also been added to content associated 

with the "Quotes" category. This versatility allows us to manage any specific need of each individual 

case. Each content can therefore be described by properties in a 100% representative way. 
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Adding new content (file or folder) 
 

Usage content is a single file or folder (containing other folders and files) that is managed through 

FileEspresso. This program automatically stores them in the "Home" folder set when first started. It 

also allows you to combine a category and set the values of all the related tags, in order to describe 

what we are storing and facilitate the search later. In fact, when we think of something that we have 

digitized in a file, perhaps we do not remember the name of the file, but what it represents, we 

remember the "values" of the "tags" or part of them. The search power of FileEspresso lies precisely 

in its intelligent search. 

 

To add a new file there are two different ways. You can right-click, select the "New Content" command 

from the popup menu, then select the type of file to add. Alternatively, in the "Content" command 

bar, select the "New file" command (the file type will be selected later). 

 

Follow the wizard's instructions to insert the new file. In a similar way you can add a new folder. 
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Adding existing content 

To add existing content (file or folder) there are two ways. You can use the drag&drop function by 

taking the file/folder directly from the desktop (or from Windows Explorer) and dragging it into the 

"FileEspresso" window. The content import wizard starts automatically with the selected file/folder. 

Alternatively, in the "Content" command bar, select the "File insert" or "Folder insert" command. The 

same wizard starts but you will have to select the content later, in the first page wizard. 

 

Follow the wizard instructions to insert the content. The second page of the wizard deserves special 

attention. You are asked what type of action to apply to the content. If the content being imported 

is stored in a temporary area (for example the user desktop or the internet download folder) and can 

be removed at the end of the import, it is recommended to use the third option (MOVE). If you want 

to manage the content where it is stored and do not want to duplicate or move it, select the first 

option "CREATE A LINK". In all other cases select the second option "COPY". The copy option will 

duplicate the content by storing it in FileEspresso's "Home" folder. The original content will not be 

managed in any way. 

 

Using the FileEspresso "Home" folder would be recommended to centralize all content. However, 

this choice is at the user's discretion. 
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Deleting or recovering content 

To delete content, select the relevant line, right-click and in the pop-up menu select the "Delete" 

command. Alternatively, select the "Delete" command in the command bar at the top. 

When the content is deleted it disappears from the list of available contents. This is not a physical 

deletion because the content is moved to the "FileEspresso" trash can. It is always possible to recover 

it at any time. To do this, select the "Undelete" command. A window will appear with a list of all 

deleted contents. 

 

To recover specific content, select it in the list, right-click and in the popup menu select the "Restore 

selected" command. To restore all the contents in the trash, select the "Restore all" command. 

The "Delete selected" command is used to delete specific content from the trash. The "Delete all" 

command must be used with particular care because it permanently deletes all the contents of the 

trash can. For further security, however, contents deleted from the Recycle Bin (only linked files and 

folders) are moved to the Windows Recycle Bin. By emptying the Windows Recycle Bin, the contents 

are permanently deleted and can no longer be recovered. 
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Using the calendar 

In the content definition wizard, at a certain point a page is proposed that allows you to activate the 

display of the content in the calendar and also set a reminder for a job that must be done with that 

content. It is always possible to activate these settings later. For example, select content so that the 

relevant row is highlighted, then select the "Edit" command in the command bar at the top (in the 

"Content" section). 

 

When the calendar has been enabled you can see the content schedule in the calendar view. A 

window showing due or overdue reminders opens automatically based on the times you set. It is 

possible to snooze a specific reminder using the "Snooze" button. To accept a reminder, select the 

"Dismiss" command. The reminder will no longer be shown for that specific event. 
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Setup and run automation 

In the content definition wizard, at a certain point a page is proposed that allows you to set a 

sequence of commands (automation). You can always activate these settings later. For example, 

select the content so that the affected line is highlighted, then select the "Edit" command in the 

command bar at the top (in the "Content" section). 

 

If a sequence of commands is defined, when the content is opened, the related automation is also 

executed at the same time. To run the automation only, without opening the content, select the 

content row and then click on the "Run automation" command in the "Content" section. 
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Searching for content 

To quickly search for content, use the "Basic search" commands in the command bar, "Content" 

section. Type some text to search for at the level of any tag associated with the content and press 

the button with the filter symbol to perform the search. 

 

If this type of search does not produce the expected results, you can perform an advanced search. 

To activate the relevant panel, click on the "Search mode" command and select "Advanced". In this 

panel it is possible to define, for each tag, the comparison criterion and the value to search for. 
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Export/Import content 

To export a single content, select the relevant line and in the "File" menu select the "Export 

content" command. A dialog box appears. Select the folder where you want to export the contents 

and the name of the export file (a file with a .ZIP extension). Press the "Save" button to confirm and 

execute the export. 

To perform the reverse operation, in the "File" menu select the "Import content" command. In the 

dialog box, select the file with the .ZIP extension exported by FileEspresso. Once the contents of the 

selected file have been validated, the data is imported into FileEspresso. 
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Troubleshooting 
 

 

FileEspresso is a constantly evolving app. In case of problems, it is possible to analyze it by reading 

the LOG file. If you are unable to resolve the problem yourself, you must open a request to technical 

support. 

 

 

LOG file 
 

In order to investigate any bugs and problems, the program records the most important operations 

and errors detected in a log file. It is a text file that can be opened with a program such as Notepad. 

This file is cleaned every time the program starts. Therefore, if you encounter a problem, before 

restarting the program, save the LOG file that is generated in this path: 

 

"%userprofile%\appdata\Roaming\FileEspresso" 

 

 

Get technical support 
 

To obtain technical support, enter the "Help" section and select the "Get support" command. You 

will be redirected to the reserved area of the NESOGE website. If you have not yet registered an 

account, you need to do so by pressing the "New account" button. Otherwise, enter the user and 

password of your account. During account registration, you must provide a valid and active email 

address because the account activation link will be sent to that address. 

 

 

If you think this program is useful, please support us with a small donation (click on the heart icon). 

Thanks for your attention. 
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Version history 
 

 

Below is the history of the versions released. 

 

 

Version 3.0.0 – 07/01/2023 

• Publication of the first desktop version in FREE USAGE mode 

 

 

Version 3.0.1 – 19/01/2023 

• Fixed a bug when moving a folder in the import an existing folder wizard 

• Double-click command in grid data view was ignored (fixed) 

 

 

Version 3.0.2 – 29/01/2023 

• Fixed a bug that doesn't display calendar reminders on the last day of the month 

• Application settings are now retained if the program is uninstalled and reinstalled or in the 

case of a version update 

• Added detailed information in the log 

 

 

Version 3.0.3 – 01/02/2023 

• Fixed a bug in the calendar view that did not display reminders beyond those of the current 

month 

• Improved security by masking the system access password on the screen 

• Review of some on-screen labels 

• Fixed a bug that did not allow you to edit content from the calendar view 

• In the "Edit > General" tab, the possibility of modifying the category of a content has been 

added 

 


